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Camera Raw is a simplified version of Adobe Lightroom and comes free as part of Adobe Photoshop.  
In this Lesson we show you how to Open Images in Adobe Camera Raw, directly inside Photoshop, rather than using 
Adobe Bridge or Mini Bridge.  “Camera Raw” is similar to “Lightroom” and can be used to adjust highlights, shadows, 
vibrance, saturation, clarity, and white balance. “Camera Raw” is good for adjusting images that have too much 
brightness, or shadows or shade in them. This lesson covers Camera Raw 7.0 from CS6. The newer CC version has 
even more features, such as the Radial Filter, and the Dehaze effect for fixing washed out bright skies.   
WARNING: DO NOT EVER PRESS THE ESC KEY IN CAMERA RAW, IT CLOSES YOUR IMAGE WITHOUT SAVING IT! 
 

Opening a File in Camera Raw 
 
In Adobe Photoshop CS6,  Do File > Open As  (not File > Open like you normally would), then in the “Files of Type” 
box, use the drop down list to change to “Camera Raw” as shown below:  
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Make sure you mouse wheel scroll up and down the list and use “Camera Raw” and not “Photoshop Raw”.  
 
Your image will then Open in Photoshop inside the Camera Raw editor like this:  
 

 
 
The above image is a JPG image that is very bright on the left hand side, and dark and shadowy on the right hand 
side. This can be seen in the top right hand histogram. We are going to use Camera Raw to correct this.  
 
   

Toggle to Full Screen and Back Again  (and Viewing Camera Raw Changes) 
 

 
 
Go Fullscreen by clicking the Full Screen Icon that is in between “Preview” and the Histogram as shown above.  
 
(Ticking and unticking Preview shows before and after images, to see the Camera Raw changes you have made).  
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Zooming in and Out 
 
There is a Magnifying Glass Icon in the top left hand corner, but it only zooms in and not out. To zoom back out, use 
the magnification controls in the bottom left hand corner, and choose “Fit in View”.   
Or just use Ctrl+ and Ctrl- like we do for zooming in and out on web browsers.  
 

 
 
 

The Top Menu Icons 
 

 
 
From Left to right these are the Magnifier Zoom In, The Hand Moving Tool, The White Balance Tool (first dropper). 
Note that we often do White Balancing on a Photo optionally at the end of processing, by dipping into an object in 
the image that should be white, and then it will go white and all the other colours will adjust accordingly.   
 
The Colour Sampler, (the second dropper), allows you to click on a colour in the image and then supplies the RGB 
numerical values of that colour.   
 
The 5th tool along is the “Targeted Adjustment Tool” . This tool changes your Histogram Curve or Saturation, etc but 
in specifically targeted areas of the image, such as the blue of the sky, or the green of the leaves.  Eg. Place the target 
on a dark area and drag, and the whole image becomes lighter throughout when in Parametric Curve mode. Click 
and HOLD on the target icon to see all of the options. This is a great tool, and there is a video on it at this link:  
Targeted Adjustment Tool Video:  https://www.youtube.com/watch?v=OnyelYu_oIA  
 
The next tool to the right is the Crop Tool, then after this the maths angle symbol is the Straightening Tool.  
 
The Paint Brush with spots around it is the Spot Healing / Clone stamp tool. We will show how to use this tool later 
on to remove some big leaves by “healing” over the top of them using this tool.   
 
Then we have the Red Eye fixing tool, followed by the Adjustment Brush, and the Rectangular Graduated Filter.  
Watch the following YouTube videos about these tools:  
 
Adjustment Brush Video:   https://www.youtube.com/watch?v=P-A70ncl9W4  (17 mins highly comprehensive) 
  
Graduated Filter Video: https://www.youtube.com/watch?v=yi0A8eaBct0  (5 minute Lynda.com video on Sky)  

https://www.youtube.com/watch?v=OnyelYu_oIA
https://www.youtube.com/watch?v=P-A70ncl9W4
https://www.youtube.com/watch?v=yi0A8eaBct0
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How to Open a Camera Raw Image in Photoshop (and Save the Image)  
 
When you have finished making adjustments in Camera Raw, go out of full screen mode and click the “Open Image” 
button down at the bottom right hand corner to open the image in Photoshop. You can then make further 
Photoshop adjustments if you want to, and then save your image as a JPG using Photoshop.  
 

 
Using the Adjustment Brush in Camera Raw  
 
Watch the video below on the Adjustment Brush, and then use it on the “Beaches2400” photo to brighten up the 
lady on the left around her eyes and over her eyes. Add some highlights to the hair of both ladies, and also lighten  
up their teeth to make them whiter. (Eg, using the brush increase the Exposure by somewhere between 0.5 and 1.5)    
 
Adjustment Brush Video:   https://www.youtube.com/watch?v=P-A70ncl9W4  (17 mins highly comprehensive) 

 
                              Before                                                                                        After 

 

 
 
The effect is very slight, the idea is to lighten up the eyes a little, and make the hair a little bit lighter.  
 
The “Before” start file is called Beaches2400.jpg in the resources folder.   
 
Remember in Photoshop to use File > Open As  and choose Camera Raw from the drop down list of file types.  
 
For images to practice with go to:  www.photosbypassy.com/CameraRawImages 

https://www.youtube.com/watch?v=P-A70ncl9W4
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Using the Targeted Adjustment Tool in Camera Raw  
 
Watch the following video about making Targeted Adjustments, paying particular attention to the sections about 
adjusting up the Saturation of Blue Sky and Green Plants. (First hold down on the Tool and choose “Saturation”). 
 
Targeted Adjustment Tool Video:  https://www.youtube.com/watch?v=OnyelYu_oIA 
 
The following image of a baby Giraffe in Africa is a very washed out light colour, due to it being a very hot dry dusty 
day when it was taken by Photos By Passy at Kruger National Park in South Africa.    
 

 
 
Using the Targeted Adjustment Tool in Camera Raw, pump up the Saturation of the sky and the green plants to make 
an improved image with more “punch” like this one.  (Click “Open Image” down the bottom of Camera Raw which 
will take the image into Photoshop where you can  increase the Contrast.)   
 

 

The start image shown  
here is “Giraffe2400.jpg” and 
can be found in the resources 
folder for this lesson.  

https://www.youtube.com/watch?v=OnyelYu_oIA
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Using Graduated Filters in Camera Raw  
 
Watch the following video about applying a Graduated Filter to an image to improve the sky:  
https://www.youtube.com/watch?v=yi0A8eaBct0 
 
Apply a graduated Filter to the following image to lower the exposure in the sky and clouds.  
Then use the Targeted Adjustment Tool to make the greens of the trees more intense, and the sky more blue.   
Use the Adjustment Brush to paint over and make the distant mountains darker by lowering exposure.  
Click on “Open Image” to take the image into Photoshop and use the clone stamp on the white quarry marks on the 
distant hills as well as adjusting Brightness and Contrast. Save the finished image.   
 

Before Image : “MaroondahDam3000.jpg” 
 

 
 
 

After Image  
 

 

https://www.youtube.com/watch?v=yi0A8eaBct0
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The Camera Raw Adjustments Panels  
 
In the right hand side column of Camera Raw, there are several different panels:  
 

 
 
 

1. The Basic Panel, where we start doing our first adjustments.  
 
2. The Tone Curve Panel to darken or lighten problem areas, like using the Curves Panel in Photoshop.  
 
3. The Sharpening Panel for adjusting and balancing sharpness and noise.  
 
4. HSL (Hue Saturation Luminosity) and Grey Scale adjustments.  
 
5. Split Toning for monochrome (eg. B&W Photos) to adjust the highlights and shadows separately.  
 
6. Lens Corrections to correct lens Distortion, Vignetting, and colour fringe Chromatic Aberration.  
 
7. The Fx Effects to add film grain, or dark vignette corners, and other special effects onto our images.  
 
8. Camera Calibration for cameras that do more Greens and Blues in Landscape Mode than in Portrait.  
 
9. Presets – Allows us to access any Camera Raw Presets that we have saved previously, or downloaded 
from the web.   
 
10. Snapshots – we can take a snapshot of our settings, eg. Save the current settings in history, so we can 
go back to them later on if we want to.  
 
These ten functions are covered in some of the examples we do below, as well as in some of the Videos 
that are listed near the end of this lesson.  
 
 

1 2 6 7 8 9 10 4 3 

4 

5 
 3 
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Using the Camera Raw Adjustments Panels  
 
The following image “PointingOrig.jpg” is a bit too dark, and the sky is very white with no blue in it.  
 

 
 
The first thing we do is open the image in Camera Raw by using Photoshop CS6 and doing File > Open As  (rather 
than normal Open) and make sure the file type we choose is “Camera Raw” in the scroll box, rather than Photoshop 
or any other file types. This will give us the following on our screen:  
 

 
 
We are on the First tab in the right hand column, which is the “Basic” tab:  
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The Basic Tab gives a number of sliders we can adjust positive right, or negative left.  
Double click on any slider to make it return to the zero middle position.  
 
The first two sliders are for White Balance and we can slide them right and left.  
 
There is also a Drop Down Box where we can choose “Auto” or “As Shot” by the camera, or “Custom” if we want to 
set the sliders to our own position.  Open As camera raw the PointingOrig,jpg image, and play around with the 
Temperature and Tint sliders and see what happens. (There is also a WB Dropper on the top of screen next to the 
hand symbol. This can be used to dip into a white object we may have on the image and set White Balance.)  
 
We have decided to use the “Auto” drop down setting for the image, which made the skin tones look a bit better.  
 
The next group of Basic Sliders also have an “Auto” option on them:  
 

 

At the moment all of the sliders are at the 
zero middle position.  
 
If we click on Auto, then Camera Raw will 
figure out all of the slider settings it thinks 
are best and move all of the sliders for us.   
 
Click on “Auto” and see what happens to 
the “PointingOrig.jpg” image. When we 
tried this we noticed that blue sections 
started showing up in the previously white 
sky, and overall the image was improved.  
 
If we now click on “Default” we should see 
all of the sliders return to their zero middle 
position.  
 
We find it is often good to use “Auto” to 
get initial slider settings, and then further 
tweak and adjust them ourselves.  
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Here is the image immediately after clicking the “Auto” option in the Basic Panel:  
 

 
 
Remember that we can tick and untick the “Preview” check box at the top of the screen to see the before and after 
images at any time.  This is a better method than going back to “Default” after we have made some adjustments.  
  
See the Videos section of this lesson for Videos which go through the Basic Pane settings in detail.  
Eg. Videos like:  
 
Two useful things are that you can hold down the Alt key while sliding the whites and the blacks.  
 
For example on the Whites slider, if we hold down Alt and slide all the way to the left, the screen goes entirely black. 
From this position we need to slide to the right until some coloured dots start appearing on the black screen. We 
usually stop at this point. If we keep going all the way to the right past this point, we will probably “blow out” the 
brightness highlights, and lose all of the blue in our sky and have too much white.   
 
What we basically ended up doing was keeping most of the Auto settings Camera Raw did for us, but sliding the 
shadows a bit further to the right to (+80) instead of +50 to lighten things up a bit.  
 
The last three settings on the Basic Pane are the  
Clarity, Vibrance, and Saturation.  
 
Clarity adjusts the Contrast up, while at the same time adding Sharpening.  
It is good to zoom in 100% down the bottom left hand corner to see 
exactly what the Clarity is doing.  
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Saturation increases the intensity of all of the colours at once if we slide to the right, and decreases the colour when 
we go to the left. If we go all the way to the left, all of the colour goes and we get a black and white grey image.  
 
Vibrance also changes colour intensity, but what it does is look for colours that are dull, and only increases the 
intensity of those colours. Other colours which are already bright remain as they are. Vibrance tries to equalise the 
intensity of all of the colours, so it is kind of like “Smart” Saturation.  
  
For our image we found that increasing the Clarity to +68 and Vibrance to +58 gave us a look that we liked: 
 

 
 
We found that these settings basically brightened up the Photo to make it look like the sun is shining, whereas the 
original photo we took was in overcast cloudy conditions without any sunlight. (Tick and Untick “Preview” checkbox 
at the top to see this, as shown below).  
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Using Camera Raw is great for shots taken in dull cloudy conditions, which look dark and a bit lifeless straight out of 
the camera.  
 
These “Basic Panel” adjustments are all we are going to do in Camera Raw for this shot, and so all that remains now 
is to use the “Open Image” button at the bottom to Open the image up in Photoshop so that we can then save it to 
ready for the Web as a 2048 pixels wide JPG.    
 
The Open Image button has 3 options, we usually Shift click it to Open as a “Smart Object” as explained in the next 
section below.  
 
 
 

The Open Image Button – Camera Raw to Photoshop Switching 
 
Most people just click the “Open Image” button at the bottom right hand corner, to finish up in Camera Raw and 
take the image into Photoshop. However, we are better off hovering the mouse over the button and then hold down 
the Shift key while clicking the button to Open our image in Photoshop as a “Smart Object”.   
 
Eg. At the last step where we take it into Photoshop using the “Open Image” button, if we hover over this “Open 
Image” button there are Alt and Shift key options about how we take it into Photoshop. We have found that the best 
option is to Shift and click the button to get a “Smart Object” that we can reopen as Camera Raw anytime later on in 
Photoshop.  
 
Using Shift and Opening as a Smart Object means that it all looks normal in Photoshop, but whenever we double 
click the Thumbnail image in the layers panel in PS, it takes us back into Camera Raw to make additional changes.  
This is our best option, to be able to go back into Camera Raw at any time.  
 
 

Improving Bright Sunlight and Shade 
 
The following image is very washed out because the camera has overexposed the top half due to the dark shade in 
the bottom half.  
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By doing File Open As Camera Raw and then using the Basic Panel we have managed to greatly improve the original 
cow photo.  See if you can do something like this to the original cow image.  
 

 
 
 

Replacing the Sky  
 
The original Pond image is very dark and dull with a flat white sky.  First we used Camera raw to brighten the image 
up and sharpen the rocks. We also used the adjusting brush to make the background mountains stand out more.  
 
We took the image into photoshop and saved it as a JPEG. We opened the JOG, unlocked the background layer, and 
did our best to magic wand out the sky, but had lots of issues getting around the tree leaves.  
 
We then made a new layer and did File > Place on the BlueSky background image. The trees were still a problem and 
so we did our best with the eraser tool to remove them all. The finished image is not great, but this method would 
probably work a lot better with a sea sky horizon image.  
 

 
 
The other issue is that there is still a grey sky reflection in the pond water.  Here is a better example of fake sky:  
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Improving Car Shots  
 
In this image taken at a Car Show, the grass around the car is too bright in the sunlight. We can use a the 
GRADUATED FILTER in Camera Raw to create a filter onto the grass areas to the side and front of the car and then 
dull the grass down as shown in the settings below:  
 

 
 
Note that we had to turn the filter around so that red is at the top and green at the bottom, and then drag the green 
side of the filter right off the screen, as well as going onto the red dashed line and angling the filter:  
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The effect is to create shade onto the bright grass, which is similar to making a vignette effect so that the car is 
highlighted better in the image.  
 
 

 
 
Here are some more Car Show images that have graduated gradient filters added to the grass area near the car.  
 
The effect is subtle and only slightly noticeable, but does improve the image.   
 
 
 
 
 
 
 
 
 
 
 
 
 
In the above image of the orange car, the effect might be a little bit too much.  
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Creating a Tool Preset (Save Settings for Top Menu Tools)  
 
Our Gradient Filter for Car Images seems to work well with the following settings:  

  
 
We want to save these settings as a “Preset” so that when we open another car image, we can apply the same 
settings for the graduated filter as our starting point.  
 
To save these current slider settings as a preset, all we need to do is head back up to the menu in the upper right 
corner of the panel and click New Local Correction Setting.  
 
Once we do that, the New Local Correction Preset dialog box will appear, and we name our Preset and Click OK: 
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If we now click back onto the top right hand corner of the Graduated Filter sliders box, we should now see that a 
Preset is listed called “CarGrassGradient.  
 
Now when we open a new image in Camera Raw, and click on the top menu tools at Graduated Filter, the Filter can 
be set to “CarGrassGradient” settings, and then we can drag the filter out with these settings and apply it quickly:  
 

 
 
 
The only issue is that we do have to rotate the filter around 180 degrees, because we want to go light to dark and so 
the red side of the filter needs to be on top:  
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Making Tool Presets this way works for all of the Tools across the top Menu Bar, eg. Graduated Filter, Adjustment 
Brush, (and the Radial Filter in newer versions of Camera Raw).  
 
 

Saving Camera Raw Basic Settings 
 
In a similar way to saving a “Preset” for a Tool like the Graduated Filter, we can also save a particular sliders set of 
Basic Settings in Camera Raw.  
 
Here we have made some slider settings to make a de-saturated retro looking image:  
 

 
 
We can save these settings to a Preset, by clicking on the very top right of the Basic Panel as shown above, and then 
from the drop down list choose Save Settings:  
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We can then choose to save some of the settings or all of the settings; most times we pick “All Settings” 
 

 
 

 
 
We then set a name such as “RetroDesatCarPhoto” and save the .xmp file.  
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If we now click on the Presets tab, we will see that our settings have been saved:  
 

 
 
 

Applying a Saved Preset to Other Images 
 
All we have to do is open another image in Camera Raw, then click on the Presets tab, and then click on the Retro 
Preset we saved, and instantly our image gets all of that Preset’s Camera Raw settings applied:  
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Once we have the Preset applied, we can then click back onto the Basic Panel and make changes if we want to.  
 
The above image was a little bit too bright and white, and so we did adjust a couple of sliders, and do some cropping, 
but it was much faster than starting from the original image with no settings on it. 
 
 

 
 
The original image looked like this:  
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Trying out our Preset on a few different cars, we found that every image needed some slight tweaking, but this was 
done is less than 30 seconds by mainly adjusting the Exposure slider and the shadows in most cases. It was much 
faster than trying to open an original full colour image and trying to go retro from the very beginning.  
 

 
 
 

Free Camera Raw Presets 
 
There are free Presets available on the Web, as well as some pay for presets, just Google “ACR Presets” or “Adobe 
Camera Raw Presets”.  
 
We did try getting these free Presets: http://photoshopcafe.com/freepresets  
 
These all downloaded and unzipped okay to a folder containing “.lrtemplatefile” suffixed files, which sounds 
suspiciously like they are for Lightroom rather than Camera Raw.  
 
In Camera Raw, we went to the Presets tab, then clicked the right hand corner and tried to load in these settings.  
We could not load any of them in because none of them were .XMP files. So the free presets were not for Camera 
Raw, even though the website said we could sign up and get free presets.    
 
We then tried getting free Presets from ON1 (which is a rival company to Adobe?) and these did seem to unzip to 
XMP files:  https://www.on1.com/free/camera-raw-presets/  
 
We could apply these settings painfully one at a time by going onto the Presets tab, and then clicking in the top right 
hand corner, and doing “Load Settings”.  It would be much better if we could somehow install these .XMP files 
permanently into Camera Raw. This can easily be done, as shown in the next section.  
  
 

Installing Downloaded ACR Presets 
 
To find the file path to install them to, open up an image and in Camera Raw on the Presets tab, click on the right 
and do Save Settings, then click on the folder path it is showing to see the full path: eg.  
 

 

http://photoshopcafe.com/freepresets
https://www.on1.com/free/camera-raw-presets/
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If we copy our downloaded .XMP files to this same folder, then they should come up as available presets everytime 
we use Camera Raw.  
 
We had to restart Photoshop for the changes to take effect, but this did result in a great set of Presets from the ON1 
free file, that give some really interesting effects kind of like a big set of Instagram filters:  
 
 

 
 
The “Gritty Heavy” preset as shown above gives this nice high contrast HDR type effect.  
 
And like any Preset, we can click back onto the adjustment tab and make changes, such as removing the max 
sharpness by taking the Clarity slider down to zero which creates this glow dreamy effect:  
 
 

 
 
This great set of 107 free presets is from ON1 at this link:  https://www.on1.com/free/camera-raw-presets/ 

https://www.on1.com/free/camera-raw-presets/
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Snapshots (Versus Presets)  
 
We can make settings save points while we are experimenting around with a Photo, these are called “Snapshots”.  
 
If we make some more changes and do not like them, we can then return the settings back to the last Snapshot we 
did.  So a Snapshot allows us to return to a previous editing point on our current image, and is not something we 
have saved as a preset that we could use on lots of other images.  
 
To find out how to use Snapshots, see the 3 minute 29 mark of the following video:  
 
https://www.youtube.com/watch?v=D5AeX_c1kXw  
 
Basically “snapshot” is the multiple rectangles icon to the right of the Preset Tab icon, and you then click the new 
folder icon down the very bottom right hand corner next to the trash can icon to take a snapshot.  
 
 
 

Using the Healing Tool  
 
As a final example we will return to the image we showed at the beginning of this lesson and use the healing/clone 
tool as well as a graduated filter to fix some aspects of the image.  
 

  
 
This photo has lots of shade on the right, and bright sun making the rocks look white on the left.  
There are also some large shiney leaves we need to copy and paste heal/clone over the top of to remove them.   

https://www.youtube.com/watch?v=D5AeX_c1kXw
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First we will use the healing tool to remove the large shiney leaves.  
 
The Paint Brush with spots around it is the Spot Healing / Clone stamp tool. We will use this tool to remove those 
annoying big shiney leaves by “healing” over the top of them.   
 

 
 
When we click onto this tool we get options in the right hand corner where we will choose “Heal” and then adjust 
the brush size radius to 15 and leave the Opacity on 100 so the brush is not see through at all.  

 
 
This tool is a little tricky to use. We get two circles produced that we can move around. The Green Circle is the 
source we are copying from, and the Red circle is the target where we want to copy and blend to.  
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By moving the red circle to where a big leaf is, and then moving the green circle to some small leaves to copy in 
there, we can eventually copy and paste over all of those big shiney leaves.  
 
To go off the tool and back on click on the hand symbol on the top menu, and then back onto the paint brush with 
spots again.  
 
The technique is to get onto the paintbrush, and first click on a big leaf you want to remove.  
Camera Raw will automatically set the green source circle and copy over the leaf, but if you do not like the auto 
selection, then grab and move the green circle yourself with the mouse to use your own selection. Click on the hand 
symbol to get out of the brush tool. Then go back onto the brush again, and keep going until it is finished.  
 
WARNING: DO NOT PRESS THE “Esc” KEY IN CAMERA RAW, IT CLOSES YOUR IMAGE WITHOUT SAVING IT! 
 

 
 
 
Now we just need to do a sideways graduated filter to try and make the left hand side a bit darker: 
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As shown above the only adjustment we make is drop the exposure down to -1.30 which will make the green dot 
end go darker.  Click on the hand symbol to exit the graduated filter tool.  
 
To finish off we adjust up the Basic Tab exposure, shadows, whites, etc until we have an image we are happy with.  
 
Then we can crop the image, take it into Photoshop, Resize it and save it for the WEB.  
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Adjusting Shots Taken through Glass 
 
The following zoo animals have been adjusted in Camera Raw, and the adjustment brush then used with the 
exposure turned up to remove shadows that were on them, and make their eyes and faces stand out.  
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
The HSL panel was also used to reduce Blue and Aqua on the snake and leaves, adjust brush used to darken leaves.  

The Lizard’s head was originally in a dark 
shadow, and the overall image was pale 
from being photographed through glass.  
 
Camera Raw used to intensify the colours 
and the Adjustment Brush set to increased 
exposure to paint over the head and 
lighten up the face to be clearly visible.  
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 Videos about Camera Raw 7.0  
 
Here are some of the best YouTube videos we found about using Adobe Camera Raw.  
 
First up is an official Adobe 7 minute video about using Camera Raw on a dark and gloomy image, and really bringing 
the light and colours up to create something quite spectacular:  
 
https://www.youtube.com/watch?v=LPiCZ0mUjQ0  
 
The following 12 minute video from Lynda.com is good, except near the end where the quality of the image they are 
working on becomes quite grainy. Goes through fixing Exposure, Highlights, and Shadows, on the Basic Panel really 
well in the first part of the video:  
 
https://www.youtube.com/watch?v=aYY8hlvndfo   
 
 
The lady who made this next video has a very American voice, but her 30 minute video does give a very 
comprehensive overview of all the adjustments that can be made in Camera Raw, particularly for Landscape Photos:  
 
https://www.youtube.com/watch?v=0uUa15pjPlY  
 
 
This 15 minute video is okay and shows how to touch up a dark sand dunes image using Camera Raw:  
 
https://www.youtube.com/watch?v=K6Kc3xolcbw  
 
 
Five minute video specifically on the Basic Panel Clarity, Vibrance, and Saturation: 
https://www.youtube.com/watch?v=8VAULisFcMg   
 
Great 10 minute video all about the Targeted Adjustment Tool:  https://www.youtube.com/watch?v=OnyelYu_oIA  
 
Video showing the basics of using a Graduated Filter: https://www.youtube.com/watch?v=yi0A8eaBct0  
 
Video showing how to apply Multiple Angled Graduated Filters: https://www.youtube.com/watch?v=92F34UiO0Qc  
 
Video showing the Clone / Heal Brush in Camera Raw: https://www.youtube.com/watch?v=tTfFqhaT_TY  
 
The Clone Tool (paint brush with spots around it) is also called “The Spot Removal Tool” and here is a video about 
using the Tool to remove Spots: https://www.youtube.com/watch?v=yZQ0sONpHkA  
In this 5 minute tool, Camera Raw is actually accessed using the Filter Menu in Photoshop, but this only works in the 
latest Photoshop CC.  In earlier versions of Photoshop we have to use File > Open As on the original image.   
 
Camera Raw Presets and Snapshots seven minute video: https://www.youtube.com/watch?v=D5AeX_c1kXw   
 
 
 
 
End of Lesson  
 
 
 
 

https://www.youtube.com/watch?v=LPiCZ0mUjQ0
https://www.youtube.com/watch?v=aYY8hlvndfo
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https://www.youtube.com/watch?v=K6Kc3xolcbw
https://www.youtube.com/watch?v=8VAULisFcMg
https://www.youtube.com/watch?v=OnyelYu_oIA
https://www.youtube.com/watch?v=yi0A8eaBct0
https://www.youtube.com/watch?v=92F34UiO0Qc
https://www.youtube.com/watch?v=tTfFqhaT_TY
https://www.youtube.com/watch?v=yZQ0sONpHkA
https://www.youtube.com/watch?v=D5AeX_c1kXw

